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About This Document

This document should ease and speed up your working with the main Tutorial ‘Train the Users’, which is accessible online on the Internet. You find it under the address:

http://www.aib.uni-linz.ac.at/accelerate/ttu/

This handout provides only a reminder in form of short Windows concept explanation, keyboard shortcut tables, and a short overview of Internet Explorer. Blind users can also find a number of tactile graphics corresponding to some elements of Windows Graphical User Interface (GUI). These foils build an extra booklet and have its own numbering marked by the letter A (for Appendix) before each foil number. You find the foil number in the upper left corner of each foil.

Computer Braille

This note is for the Braille users only!

We use the computer Braille reduced to 6 dots. That means, that if you are a new computer user, you have to learn some changed Braille signs.

The refreshable Braille displays have the ability of using 8 dots. The traditional Braille system is extended for this end by two additional dots. The dot 7 is placed under the dot 3 and the dot 8 under the dot 6.

All English lowercase letters are unchanged. The uppercase letters are built by adding the dot 7 to the lowercase letters. We don’t use uppercases in the paper print of this document in order to achieve the best readability.

1 Using Windows with Keyboard


1.1
Starting Applications

1.1.1
Desktop (Foil a.1)

The Windows Desktop is the parent of all Windows. You can see the symbols on it, navigate between them and activate them when you minimize all application windows.

To put the Windows focus on the Desktop

Press the WINDOWS key+D or

CONTROL+ESCAPE, ESCAPE, TAB, TAB.

The second pressing of WINDOWS+D, during the Desktop has the focus, will restore all minimized windows.

Some Screen Reader programs have their own utilities for switching between running applications and for focusing the Windows Desktop.

To start an application from the Desktop, once the focus is on the Desktop, use the ARROW keys to highlight it and then press ENTER.

1.1.2 Windows Start button and Start menu

To access the Start button: Press CONTROL+ESCAPE or WINDOWS key.

When you press the Start button the Start menu will appear. None of the options in it are initially highlighted.

To move through the options in the Start menu use the UP or DOWN ARROW keys or the first letter of an item repeatedly. In case that only a single item starts with the key pressed, this item will be activated. That means a sub-menu will appear or a program starts.

Moving up or down the Start menu will highlight each menu item in turn. The most menu items on the highest level of the Start menu are sub-menus. The sub-menus are marked by three dots and the speech output of every Screen Reader program should inform you about it.

To enter a selected sub-menu press RIGHT ARROW.

For example, in the Windows Start menu, if you had pressed RIGHT ARROW when the item ‘Programs’ was highlighted, the ‘Programs’ sub-menu will appear with its first item selected.

To leave a sub-menu and return to its parent menu press LEFT ARROW.

For example, if you press LEFT ARROW to leave the ‘Programs’ sub-menu, the sub-menu will be closed and the parent menu opens with the item ‘Programs’ selected.

To leave the whole menu system without selecting an item, press ALT.

1.1.2.1
Programs

All Windows applications can be accessed from the Programs sub-menu of the Start menu. You can select this option directly from the Start menu by pressing P.

1.1.2.2
Documents

This sub-menu contains a list of the documents that you have recently accessed.  This sub-menu is useful for continuing work on a document without first having to find it on its proper place in the filing system. You can select this option directly from the Start menu by pressing D.  When you select a document from this menu, Windows will run the application that created this document automatically for you, and load the appropriate document.

1.1.2.3
Settings

In this sub-menu you will find options for customizing Windows. You can select this option directly from the Start menu by pressing S.

1.1.2.4
Find

This sub-menu helps you to find files located on your disk. You can select this option directly from the Start menu by pressing F.

1.1.2.5
Help

This option is a useful place to find out about Windows. You can select this option directly from the Start menu by pressing H.

1.1.2.6
Run

If you select this menu item, a dialog box will appear and you will be prompted to enter a command. That means you can type in the name of a program with its full path and possible parameters to run it.  When you have typed in the command press ENTER to activate it, or press ESCAPE to cancel. You can select this option directly from the Start menu by pressing R.

1.1.2.7
Shut Down

Shut Down allows you to finish your Windows session.  If you select this option, a dialog box with a number of options appears.  Use the UP and DOWN ARROW keys to select the one you want and press ENTER.  If you did not want to finish your Windows session, press ESCAPE. You can select this option directly from the Start menu by pressing U.

Always use the Shut Down option to finish your Windows session; never just turn your computer off.

1.2
Windows Applications – Programs (Foils a.13, a.14)

‘Application’ is the Windows name for a program you use to settle a specific task.

Every Windows application gets from the system its own application window after been started. Immediately after the program start this application window gets the ‘focus’. That means the user can interfere with the application at this moment. He or she can e.g. write, draw or execute program specific commands.

The Application window and its child windows

The most applications have a plenty of visual elements within their main window. All of them are contained in one of the child windows:

Document window

Main menu bar

Tool bars

Status bar

Scroll bars etc.

You can learn more about all of the elements in the Online Tutorial. Here we confine ourselves to the very basics.

1.2.1
Menus (Foils a.11-a.14)

It is probably best to start an application like Editor, WordPad or Microsoft Word to exercise with.

To start one of these applications:

Open the Start menu with CONTROL+ESCAPE or WINDOWS key

Press P to select the menu option ‘Programs’

Microsoft Word you find in the Programs sub-menu, WordPad and Editor in the ‘Accessories’ sub-menu of ‘Programs’

After you have highlighted the application you want to start, press ENTER.

You can now learn about using an application's menu system.

To activate the main menu bar, press ALT by itself. When you do this you activate the main menu bar alone, rather than a specific pop-up menu. The first main menu item is focused – mostly ‘File’.

To move between the menu items on the menu bar, use LEFT or RIGHT ARROW keys.

To enter a menu, press DOWN ARROW. A vertical menu pops up under the menu bar.

For example, in Microsoft Word, if you press DOWN ARROW when ‘File’ item is focused, the File menu will pop up with the sub-menu ‘New’ highlighted.

To choose an item from a pop-up menu, use the UP and DOWN ARROW keys to select the item you want and press ENTER.

To leave the menu system without selecting an item, press ALT again.

To go one level up in the menu hierarchy, press ESCAPE.

1.2.1.1
Menu Conventions

There are several symbols that can appear alongside the items in the menu to indicate the kind of action, which you will execute by choosing it.

If an ellipsis (...) follows a menu item then a dialog box will appear when you choose this item. The dialog box will contain options that you need to select before this command can be carried out. 

If a key combination follows a menu item then this key combination is a shortcut for choosing this item. That means, you can press this key combination to perform this command without first having to open the menu. For example, in almost all applications you can open the File Open dialog by pressing CONTROL+O.

A check mark to the left of a menu item indicates that this menu item is an option in effect. When you choose the item again (by pressing ENTER), you remove the check mark and the item is no longer in effect. For example, in the View pop-up menu of Microsoft Word you find the item ‘Ruler’ to switch the appearance of the ruler on and off.

A triangle to the right of a menu option means that this option is a sub-menu. If you choose this menu option a cascading sub-menu will appear.

Some menu items can be temporarily in grey type. That means, that this option is not available at the time.

1.2.1.2
Accelerators

Many menu items, buttons and check boxes have shortcut keys for activating them. For example, in MS Word you can press X whilst in the File menu to Exit the application. The accelerators are visualized as underlined letters.

1.2.1.3
The Application Control Menu

The Control menu icon is located in the upper left corner of each application window.

To activate the Control menu press ALT+SPACEBAR.

The Control menu consists of options for resizing, moving and closing the application window. We recommend you to run all your applications maximized to have the most possible amount of text in the window visible because the application window fills the whole screen.

1.2.2
Exiting from an application

The simplest way to exit from an application – to end the execution of a program – is to press ALT+F4. That is the shortcut for the Exit option from the File menu.

Sometimes consists the only possibility for exiting a program in closing the application window with the Close button. This is the button in the upper right corner of each application window.

1.2.3
Dialog Boxes (Foil a.10)

This section discusses how the various controls can be used.

1.2.3.1
Moving around a Dialog Box

Often you need to move within a dialog box to select one or more options.  The currently highlighted option is known as the focus and either appears as a dotted rectangle, a cursor or a highlight.

To move within a dialog box:

Press TAB to move to the next option or

Press SHIFT+TAB to move to the previous options.

As an exercise tab through the Open Dialog Box of MS Word. You get it open by pressing CONTROL+O.

When you choose the "OK" command button, the dialog box closes and the new options your changed in the Dialog Box are active or an action will be performed.

You can also cancel a command. To close a Dialog Box without carrying out a command:

Highlight the Cancel button and press SPACEBAR or ENTER or

Press ESCAPE from anywhere within the Dialog Box.

1.2.3.2
Buttons (Foil a.2)

To activate a button, tab around until the button you want is selected, then press SPACEBAR.

1.2.3.3
Check Boxes – Option Buttons (Foil a.3)

Check Box is a switch that you can turn on or off. Mostly you find more Check Boxes grouped together because of the similarity of options you can choose.

When a Check Box is selected, it contains a tick.

To select or deselect a highlighted Check Box, press the SPACEBAR.

1.2.3.4
Radio Buttons (Foil a.4)

Radio Buttons or Option Buttons represent a group of mutually exclusive options.  You can select only one option at a time. For example, choose the Shut Down option from the Start Menu. Here you find a group of Radio Buttons with which you can choose between more shut down modes.

To select a Radio Button, use the UP or DOWN ARROW keys to move through the available options until you reach the one you want. The focus moves automatically with.

1.2.3.5
Edit Fields (Foil a.5)

The control, in which you can input information, is called Edit Box.  When you move to an Edit Box, a cursor will appear automatically.  If this Edit Box already contains text, the whole text is highlighted. Any text you type will replace it.  You can also delete the existing text by pressing DELETE or BACKSPACE. To add some text or to change it, press one of the ARROW keys first.

1.2.3.6
List Boxes (Foil a.6)

A List Box displays a list of choices. For example you can choose a file to open, a font in which a selected text has to appear etc.

To select an item from a list box:

Use the UP or DOWN ARROW keys to move through the list until you reach the one you need or

Type in some letters the item starts with to jump immediately to it.

1.2.3.7
Drop-Down List Boxes (Foil a.7)

A Drop-Down List Box appears initially as a rectangular box containing the current selection.  When you press the CURSOR UP or CURSOR DOWN key a list of choices appears which you can go through with ARROW keys.

To select an item from a Drop-Down List, highlight the current option and then use UP and DOWN ARROW keys to move through it. You can also type a few initial letters of the item you search for to jump immediately to it. When the item is highlighted, press ENTER.

1.2.3.8
Sliders and Spinners (Foil a.8)

To change values you have to use sliders and spinners. When these controls are selected, use ARROW keys to change the values. Which ARROW key increases or decreases the value is due to the application. One example for these controls is setting the system time and date.

1.2.3.9
Scroll Bars (Foil a.9)

The most texts and many graphics are too large to fit on the screen. Scroll bars and sliders are controls, with which you can virtually move the screen up and down, left and right above a document.

Use DOWN ARROW or PAGE DOWN to scroll down the document, UP ARROW and PAGE UP to scroll up.

To scroll left/right with the keyboard could be often a problem, because some programmers forget to make it possible. Whenever the possibility is given, check the option ‘Break on Window’ in the View Menu or switch all scroll bars off.

1.3
Taskbar (Foil a.1)

On the bottom of the screen there is a bar containing the symbols of the running applications. You find there also the minimized applications, which have currently no window open on the screen.

To cycle through the running applications, hold down the ALT key and tap the TAB key. After you found the application you want to restore, release the ALT key.

1.4
Clipboard

The Windows Clipboard is a temporary storage place helping you to easy move or copy various objects like files, folders, text segments, graphics etc.

As for the other actions, the objects you want to put on the Clipboard have first to be selected or marked (highlighted).

To select

A region of text or some amount of consecutive objects in a list, 

Position the focus on the beginning or end of the area to be marked

Hold down the SHIFT key

Use ARROW keys to move the focus to the opposite end of the area

Release the SHIFT key.

More non-consecutive objects in a list

Move the focus to the first chosen item

Hold down the CONTROL key

Use the ARROW keys to move the focus to the next chosen object

Press the SPACEBAR to select it

Go on using ARROW keys and SPACEBAR until you have selected all items, which have to be put on the Clipboard

Release the CONTROL key.

To cancel the selection, press simply an ARROW key.

Warning: if you press an alphanumeric key whilst a text region is selected, the character that you typed will replace the entire selection.  If you do this by accident, press CONTROL+Z to undo the change.

After a whole text region or all the wanted elements from a list are selected, you can

Cut the selected objects to the Clipboard by pressing CONTROL+X or

Copy them by pressing CONTROL+C.

To paste an object from the Clipboard into an application

Move to the place in the application you want the object to be inserted. That can be anywhere in a text loaded in a Word Processor, in some other list you want to put the items in etc.

Paste the object from the Clipboard by pressing CONTROL+V.

2
Keyboard Shortcuts

2.1
Windows System Shortcuts

Below are the Microsoft Windows system-wide keyboard shortcuts that are available from within every Windows application.

Action
Shortcut




Minimize all Windows
WINDOWS key+M 

Open the Start Menu
WINDOWS key or CONTROL+ESCAPE

Open Windows Explorer
WINDOWS key+E

Open the Find: All Files Dialog Box
WINDOWS key+F

Open the Run Dialog Box
WINDOWS key+R

Open the System Properties Dialog Box
WINDOWS key+BREAK

Open the Find Computer Dialog Box
WINDOWS key+CONTROL+F

Open the Context Menu
APPLICATION key or SHIFT+F10

Cycle between the running applications
ALT+TAB

Open the application’s Control Menu
ALT+SPACEBAR

Open the document’s Control Menu
ALT+MINUS

Copy to Clipboard
CONTROL+C

Cut to Clipboard
CONTROL+X

Paste from Clipboard
CONTROL+V

2.2
Editing Shortcuts

In all standard Edit Boxes as well as in the most word processing applications you can use following groups of keyboard shortcuts:

2.2.1 Movement Keys

Action
Shortcut

Next character
RIGHT ARROW

Previous character
LEFT ARROW

Next word
CONTROL+RIGHT ARROW

Previous word
CONTROL+LEFT ARROW

Next line
DOWN ARROW

Previous line
UP ARROW

Next screen page
PAGE DOWN

Previous screen page
PAGE UP

Beginning of line
HOME

End of line
END

Beginning of file
CONTROL+HOME

End of file
CONTROL+END

2.2.2
Selecting Keys

Action
Shortcut




Select next character
SHIFT+RIGHT ARROW

Select previous character
SHIFT+LEFT ARROW

Select next word
SHIFT+CONTROL+RIGHT ARROW

Select previous word
SHIFT+CONTROL+LEFT ARROW

Select to the end of line
SHIFT+END

Select to the beginning of line
SHIFT+HOME

Select to the same hor. position in the next line
SHIFT+DOWN ARROW

Select to the same hor. position in the previous line
SHIFT+UP ARROW

Select to the end of paragraph
SHIFT+CONTROL+DOWN ARROW

Select to the beginning of paragraph
SHIFT+CONTROL+UP ARROW

Select to the end of file
SHIFT+CONTROL+END

Select to the beginning of file
SHIFT+CONTROL+HOME

Select all
CONTROL+A

2.2.3
Deletion Keys

Action
Shortcut




Delete next character
DELETE

Delete previous character
BACKSPACE

Delete selected text
DELETE

Undo an editing action
CONTROL+Z

2.3
Shortcut Keys in Menus and Dialogs

Action
Shortcut




Toggle Main Menu on/off
ALT

One Menu level up
ESCAPE

Move between Main Menu items
LEFT and RIGHT ARROWS

Move within a Pop-up Menu
UP and DOWN ARROWS

Activate a Menu item
ENTER

Next element in a Dialog Box
TAB

Previous element in a Dialog Box
SHIFT+TAB

Next element in a List
DOWN ARROW

Previous element in a List
UP ARROW

Toggle a Check Box on/off
SPACEBAR

Push a Button
SPACEBAR

Choose a Radio Button
ARROW keys

Cycle between several property sheets
CONTROL+TAB

2.4
Internet Explorer Keyboard Shortcuts

You can use shortcut keys to view and explore Web pages, use the Address bar, work with favorites, and edit.

2.4.1
Viewing and exploring Web pages

Action
Shortcut




Display the Internet Explorer Help, or when in a dialog box, display context help on an item
F1

Toggle between Full Screen and regular view of the browser window
F11

Move forward through the items on a Web page, the Address bar, and the Links bar
TAB

Move back through the items on a Web page, the Address bar, and the Links bar
SHIFT+TAB

Go to your Home page
ALT+HOME

Go to the next page
ALT+RIGHT ARROW

Go to the previous page
ALT+LEFT ARROW or BACKSPACE

Display a shortcut menu for a link
SHIFT+F10

Move forward between frames
CONTROL+TAB or F6

Move back between frames
SHIFT+CONTROL+TAB

Scroll toward the beginning of a document
UP ARROW

Scroll toward the end of a document
DOWN ARROW

Scroll toward the beginning of a document in larger increments
PAGE UP

Scroll toward the end of a document in larger increments
PAGE DOWN

Move to the beginning of a document
HOME

Move to the end of a document
END

Find on this page
CONTROL+F

Refresh the current Web page only if the time stamp for the Web version and your locally stored version are different
F5 or CONTROL+R

Refresh the current Web page, even if the time stamp for the Web version and your locally stored version are the same
CONTROL+F5

Stop downloading a page
ESC

Action
Shortcut

Go to a new location
CONTROL+O or CONTROL+L

Open a new window
CONTROL+N

Close the current window
CONTROL+W

Save the current page
CONTROL+S

Print the current page or active frame
CONTROL+P

Activate a selected link
ENTER

Open Search in Explorer bar
CONTROL+E

Open Favorites in Explorer bar
CONTROL+I

Open History in Explorer bar
CONTROL+H

In History or Favorites bars, open multiple folders
CONTROL+click

2.4.2
Using the Address bar

Action
Shortcut




Select the text in the Address bar
ALT+D

Display the Address bar history
F4

When in the Address bar, move the cursor left to the next logical break (. or /)
CONTROL+LEFT ARROW

When in the Address bar, move the cursor right to the next logical break (. or /)
CONTROL+RIGHT ARROW

Add "www." to the beginning and ".com" to the end of the text typed in the Address bar
CONTROL+ENTER

Move forward through the list of AutoComplete matches
UP ARROW

Move back through the list of AutoComplete matches
DOWN ARROW

2.4.3
Working with favorites

Action
Shortcut




Add the current page to your favorites
CONTROL+D

Open the Organize Favorites dialog box
CONTROL+B

Move selected item up in the Favorites list in the Organize Favorites dialog box
ALT+UP ARROW

Move selected item down in the Favorites list in the Organize Favorites dialog box
ALT+DOWN ARROW

2.5
JAWS Shortcut Keys

Action
Shortcut




Start JAWS
No default shortcut

Quit JAWS
INSERT+F4

Open JAWS Window
INSERT+J

2.5.1
Help Keys

Action
Shortcut




Hotkey Help
INSERT+H

Keyboard Help (toggle)
INSERT+1


Press any key: short description


Press a key twice quickly: longer description

Screen Sensitive Help
INSERT+F1

Window Keys Help
INSERT+W

2.5.2
Exploring the Screen and Navigating

Action
Shortcut




Mouse Cursor Mode On
NUM PAD MINUS

Invisible Cursor Mode On
NUM PAD MINUS pressed twice quickly

PC Cursor Mode On
NUM PAD PLUS

Restrict Mouse Cursor (toggle)
INSERT+R

Left Mouse Button Click
NUM PAD SLASH

Left Mouse Button Lock (toggle)
INSERT+NUM PAD SLASH

Right Mouse Button Click
NUM PAD STAR

Right Mouse Button Lock (toggle)
INSERT+NUM PAD STAR

Move Mouse Left
ALT+SHIFT+LEFT ARROW

Move Mouse Right
ALT+SHIFT+RIGHT ARROW

Move Mouse Down
ALT+SHIFT+DOWN ARROW

Move Mouse Up
ALT+SHIFT+UP ARROW

Move Mouse To Top Of Screen
PAGE UP

Move Mouse To Bottom Of Screen
PAGE DOWN

Move Mouse To PC Cursor
INSERT+NUM PAD MINUS

Move PC Cursor To Mouse
INSERT+NUM PAD PLUS

2.5.3
Speech Control Keys

2.5.3.1
Basic Functions

Action
Shortcut




Say Current Character
NUM PAD 5

Spell Current Character Phonetically
NUM PAD 5 pressed twice quickly

Say Next Character
RIGHT ARROW

Say Previous Character
LEFT ARROW

Say Current Word
INSERT+NUM PAD 5

Spell Current Word
INSERT+NUM PAD 5 pressed twice quickly

Say Next Word
CONTROL+RIGHT ARROW or INSERT+RIGHT ARROW

Say Previous Word
CONTROL+LEFT ARROW or INSERT+LEFT ARROW

Read Word In Context
INSERT+C

Say Current Sentence
ALT+NUM PAD 5

Say Next Sentence
ALT+DOWN ARROW

Say Previous Sentence
ALT+UP ARROW

Say Line
INSERT+UP ARROW

Say From Cursor To End Of Line
INSERT+PAGE UP

Say From Beginning Of Line To Cursor
INSERT+HOME

Say Next Line
DOWN ARROW

Say Previous Line
UP ARROW

Say Current Paragraph
CONTROL+NUM PAD 5

Say Next Paragraph
CONTROL+DOWN ARROW

Say Previous Paragraph
CONTROL+UP ARROW

Say All From Cursor
INSERT+DOWN ARROW

Say Selected Text
INSERT+SHIFT+DOWN ARROW

Say Current Frame
INSERT+X

Say Text And Attributes
ALT+INSERT+DOWN ARROW

Say Top Line Of Window
INSERT+END

Say Bottom Line Of Window
INSERT+PAGE DOWN

2.5.3.2
Table Reading Functions

These functions are using the so-called virtual cursor and can be used in different applications including HTML tables viewed in Internet Explorer.

Action
Shortcut




Read Current Cell
ALT+CONTROL+NUM PAD 5

Read Cell In Next Column
ALT+CONTROL+RIGHT ARROW

Read Cell In Previous Column
ALT+CONTROL+LEFT ARROW

Read Cell In Next Row
ALT+CONTROL+DOWN ARROW

Read Cell In Previous Row
ALT+CONTROL+UP ARROW

2.5.3.3
Further Functions

Action
Shortcut




Say Current Font
INSERT+F

Say Current Colour
INSERT+5

Say Current Hotkey
CONTROL+SHIFT+H

Say Cursor Type
CONTROL+INSERT+SHIFT+C

Say Application Version
CONTROL+INSERT+V

Say Window Title
INSERT+T

Say Default Button
INSERT+E

Say Window Prompt
INSERT+TAB

Say System Time
INSERT+F12

Adjust JAWS Verbosity
INSERT+V

2.5.4
Utilities

Action
Shortcut




Open JAWS Window
INSERT+J

Shut Down JAWS
INSERT+F4

Refresh Screen
INSERT+ESCAPE

Start JAWS Task List
INSERT+F10

List System Tray Icons
INSERT+F11

Minimize All Applications
INSERT+F6

Pass a Key through
INSERT+3

List JAWS Managers
INSERT+F2

Start Auto Graphics Labeler
CONTROL+INSERT+G

Start Configuration Manager
INSERT+6

Start Frame Manager
INSERT+9

Start Graphics Labeler
INSERT+G

Start Keyboard Manager
INSERT+8

Start Script Manager
INSERT+ZERO

2.6
Supernova Shortcut Keys

2.6.1
Numeric Keypad (NUM PAD)

Action
Shortcut




Start Supernova
LeFT CONTROL+LEFT SHIFT+S

Quit Supernova
LeFT CONTROL+SPACE, ALT+SPACE, ALT +F4

2.6.1.1
Action Keys

Action
Shortcut




Open Control Panel
LEFT CONTROL+SPACE

Help
RIGHT SHIFT+SLASH

Refresh
LEFT CONTROL+SEMICOLON

Pass Next Key Through to Application
LEFT CONTROL+7

Toggle Hot Keys
LEFT CONTROL+8

2.6.1.2
Speech Keys

Action
Shortcut




Toggle Speech
LEFT CONTROL+0

Mute
LEFT CONTROL

Volume Up
LEFT CONTROL+EQUALS

Volume Down
LEFT CONTROL+MINUS

Speed Up
LEFT CONTROL+LEFT SHIFT+EQUALS

Speed Down
LEFT CONTROL+LEFT SHIFT+MINUS

Switch to Next Language
LEFT CONTROL+DOT

Switch to Previous Language
LEFT CONTROL+COMA

Row/Column Mode
LEFT CONTROL+9

Document Read
NUM PAD PLUS

Exit Document Read
ESCAPE

Exit Document Read to Navigation Mode
SPACE

2.6.1.3
Speak Keys

Action
Shortcut




Read Character
NUM PAD 4

Read Character Attributes 1
LEFT SHIFT+NUM PAD 4

Read Character Attributes 2
LEFT CONTROL+NUM PAD 4

Read Word
NUM PAD 5

Read Line
NUM PAD 6

Read to Cursor
NUM PAD 1

Read from Cursor
NUM PAD 2

Read Spreadsheet Row/Column Position
NUM PAD 3

Read Focus
NUM PAD 0

Read Control
NUM PAD DOT

Read Status Bar
NUM PAD SLASH

Read Window
NUM PAD STAR

Read Shortcut
LEFT CONTROL+LEFT SHIFT+NUM PAD DOT

Where Am I?
NUM PAD MINUS

2.6.1.4
Navigation Mode Keys

Action
Shortcut




Enter Navigation Mode
LEFT SHIFT+SPACE

Cycle Restriction
NUM PAD PLUS

Auto Train Graphics
LEFT CONTROL+LEFT SHIFT+INSERT

Teach Graphics
INSERT

Find
F3

Find Previous
F2

Find Next
F4

Go to Focus
NUM PAD DOT

Previous Line
CURSOR UP

Next Line
CURSOR DOWN

Left One Character
CURSOR LEFT

Right One Character
CURSOR RIGHT 

Previous Object
LEFT CONTROL+CURSOR UP

Next Object
LEFT CONTROL+CURSOR DOWN

Left One Word
LEFT CONTROL+CURSOR LEFT

Right One Word
LEFT CONTROL+CURSOR RIGHT

Move to Start of Line
HOME

Move to End of Line
END

Move to First Object
LEFT CONTROL+HOME

Move to Last Object
LEFT CONTROL+END

Move to Start of Object
PAGE UP

Move to End of Object
PAGE DOWN

Read Character
NUM PAD 4

Read Character Attributes 1
LEFT SHIFT+NUM PAD 4

Read Character Attributes 2
LEFT CONTROL+NUM PAD 4

Read Word
NUM PAD 5

Read Line
NUM PAD 6

Read to Cursor
NUM PAD 1

Read from Cursor
NUM PAD 2

Read Spreadsheet Row/Column Position
NUM PAD 3

Read Focus
NUM PAD 0

Exit Navigation Mode
ESCAPE

Perform Left Mouse Button Click
SPACE

Perform Left Mouse Button Double Click
ENTER

Perform Right Mouse Button Click
LEFT SHIFT+F10

Note: To spell, verbose or read using the phonetic ALPHABET USE THE "SPEAK KEYS" AND "NAVIGATION MODE KEYS" NUM PAD 0, 1, 2, 3, 5 AND 6 IN CONJUNCTION WITH LEFT SHIFT, LEFT CONTROL AND LEFT CONTROL+LEFT SHIFT RESPECTIVELY.

2.6.1.5
Text Input Keys

Action
Shortcut




Read Character
NUMPAD 4

Read Character Attributes Set 1
LEFT SHIFT+NUMPAD 4

Read Character Attributes Set 2
LEFT CONTROL+NUMPAD 4

Phonetic Character
LEFT CONTROL+LEFT SHIFT+NUMPAD 4

Read Line
NUMPAD 6

Spell Line
LEFT SHIFT+NUMPAD 6

Verbose Line
LEFT CONTROL+NUMPAD 6

Phonetic Line
LEFT CONTROL+LEFT SHIFT+NUMPAD 6

2.6.2
Magnification Keys

Action
Shortcut




Toggle Magnification
LEFT CONTROL+NUM PAD ENTER

Increase Magnification
LEFT CONTROL+NUM PAD PLUS

Decrease Magnification
LEFT CONTROL+NUM PAD MINUS

Increment X Magnification
LEFT SHIFT+NUM PAD PLUS 

Increment Y Magnification 
LEFT CONTROL+LEFT SHIFT+NUM PAD PLUS

Decrement X Magnification
LEFT SHIFT+NUM PAD MINUS

Decrement Y Magnification
LEFT CONTROL+LEFT SHIFT+NUM PAD MINUS

Pan Up
RIGHT CONTROL+CURSOR UP

Pan Down
RIGHT CONTROL+CURSOR DOWN

Pan Left
RIGHT CONTROL+CURSOR LEFT

Pan Right
RIGHT CONTROL+CURSOR RIGHT

Action
Shortcut

Move Up
RIGHT CONTROL+RIGHT SHIFT+CURSOR UP

Move Down
RIGHT CONTROL+RIGHT SHIFT+CURSOR DOWN

Move Left
RIGHT CONTROL+RIGHT SHIFT+CURSOR LEFT

Move Right
RIGHT CONTROL+RIGHT SHIFT+CURSOR RIGHT

Move to Top Left
RIGHT CONTROL+NUM PAD 7

Move to Top
RIGHT CONTROL+NUM PAD 8

Move to Top Right
RIGHT CONTROL+NUM PAD 9

Move to Left Edge
RIGHT CONTROL+NUM PAD 4

Move to Right Edge
RIGHT CONTROL+NUM PAD 6

Move to Bottom Left
RIGHT CONTROL+NUM PAD 1

Move to Bottom
RIGHT CONTROL+NUM PAD 2

Move to Bottom Right
RIGHT CONTROL+NUM PAD 3

Move to Middle
RIGHT CONTROL+NUM PAD 5

Save Position
RIGHT CONTROL+NUM PAD SLASH

Restore Position
RIGHT CONTROL+NUM PAD STAR

Image Smoothing
LEFT CONTROL+NUM PAD 8

Toggle Colour Changer
LEFT SHIFT+NUM PAD ENTER

Toggle Overview Mode
LEFT CONTROL+BACKSLASH

Cycle Primary Area
NUM PAD 7

Cycle Split Screen Orientation
NUM PAD 8

Toggle Magnification Hooks
NUM PAD 9

Toggle Tracking
LEFT SHIFT+NUM PAD 8

2.6.2.1
Magnification Window Adjustment Keys

Action
Shortcut




Modify Primary Area
LEFT CONTROL+NUM PAD 7

Create Hooked Area
LEFT SHIFT+NUM PAD 9

Modify Hooked Area
LEFT CONTROL+NUM PAD 9

Area Up
CURSOR UP 

Area Down
CURSOR DOWN

Area Left
CURSOR LEFT

Area Right
CURSOR RIGHT

Contents Up
LEFT SHIFT+CURSOR UP

Contents Down
LEFT SHIFT+CURSOR DOWN

Contents Left
LEFT SHIFT+CURSOR LEFT

Contents Right
LEFT SHIFT+CURSOR RIGHT

Make Shorter
LEFT CONTROL+CURSOR UP

Make Taller
LEFT CONTROL+CURSOR DOWN

Make Narrower
LEFT CONTROL+CURSOR LEFT

Make Wider
LEFT CONTROL+CURSOR RIGHT

Move Area with Mouse
Z

Move Contents with Mouse
C

Resize Area with Mouse
X

Exit Modification Mode
ESCAPE

2.6.2.2
Line View Mode Keys

Action
Shortcut




Line View Document Area
LEFT SHIFT+NUM PAD DOT

Line View Window
LEFT SHIFT+NUM PAD STAR

Start and Stop
SPACE

Scroll Faster
CURSOR UP

Scroll Slower
CURSOR DOWN

Flip Forward
ENTER

Move Backward
CURSOR LEFT

Move Forward
CURSOR RIGHT

Previous Line
PAGE UP

Next Line
PAGE DOWN

Go to the First Line
HOME

Go to the Last Line
END

Exit Line View Mode
ESCAPE

3
How to use the main Tutorial

‘Train the Users’ Tutorial is a Web Page on the Internet. That means, you have to use an Internet browser to be able to read it. We recommend the MS Internet Explorer for this purpose, the reason being that the most popular Screen Readers are best customized for the MicroSoft products.

3.1
What is a Web Page?

Internet is a worldwide computer network with millions of service providers and users. The services are provided through the so-called Web pages. To access Web pages you need a client application or a so-called browser like Internet Explorer, Netscape Navigator etc. 

A Web page contains more than just simple text to present the information of interest. The programming language for Internet or Web pages has the name HTML (hyper text mark-up language). It allows the integration of pictures, forms (Internet dialog boxes), maps, sound, videos and a big range of sub-programs (applets).

But for sure the greatest advantage of HTML in comparison to simple text is its oldest property: the integration of bookmarks, and internal and external links.

3.1.1
HTML Documents

The Web pages or homepages are electronic documents suitable for a network. That means, that a document can be stored in one file, in more files on the same computer or even in more files distributed among several computers anywhere in the world. The user does not have to bother with the file names or file locations. It is also very easy to navigate through the structure of a document, to look up the references or even the referred citations in other documents stored anywhere on the net.

3.1.1.1
Bookmarks

The bookmarks are the HTML elements that mark some locations in a document, to enable the browsers to immediately visit these locations by activating so-called links.

The bookmarks usually mark the headers of chapters and sections, the citations, index entries etc.

3.1.1.2
Links

A link is an active spot in a Web page, which acts as a reference to a bookmark in the same Web page, to an other Web page or to a bookmark anywhere in an other Web page. A link can be a piece of text, a picture or an area of a map or picture. A link is normally underlined but its shape depends on the Web page programmer. By clicking a link, the browser instantly visits the reference point of this link.

MS Internet Explorer allows also keyboard access for manipulating links. With TAB and SHIFT+TAB you can move forward and backward between links. You can activate the selected link by pressing ENTER.

3.1.1.3
Internet Addresses

Each Web page and each bookmark on a Web page has its own unique Internet address called URL (uniform resource locator). For example, the URL of the ‘Train the Users’ Manual is: http://www.aib.uni-linz.ac.at/accelerate/ttu/index.html.

Let’s explain as short as possible the elements of a URL following the example above.

1. http://
The first few letters of the address that are separated from the rest by ‘://’ indicate the used Internet protocol. It is mostly ‘http’.

2. www
The name of a computer. This name is separated from the rest of the address by the first appearance of a dot ‘.’

3. uni-linz.ac.at
The domain name. It can contain more parts separated by dots. It ends in most cases with the two letters indicating a country, with ‘org’ indicating an international organisation, ‘com’ indicating a commercial institution etc.

4. /accelerate/ttu/index.html
The file name of the starting point of a Web page incl. the complete path to it (folders and sub-folders). This part starts with a slash ‘/’. The slashes separate also folder and file names. If a Web page starts with a default file named ’index.html’, you are allowed to let it out. In our case it would be enough to write: ‘/accelerate/ttu/’

5. #Bookmark (not contained in our example)
In case that a link addresses a bookmark in a Web document, the name of this bookmark is added to the end of the address separated by a number sign ‘#’.

3.1.2
‘Train the Users’ Web Page

As mentioned before, ‘Train the Users’ Tutorial is a Web page. We recommend to use the Internet Explorer 5.0 or above to read it. You find the Internet Explorer Key Shortcuts in the section 2.4 of this printout.

Don’t forget to consult also the section explaining how to use best Internet Explorer with your Screen Reader before you start with the main Tutorial. You find it later on in this printout.

The Tutorial web page contains only the simplest HTML constructs and is entirely accessible for Screen Reader and Screen Enlargement users. On the very beginning you will be confronted with a simple form. You have to fill it out only once to properly set your Tutorial options. An advanced user could help you with it. Later in the course you will learn how to fill out the forms yourself.

After the Tutorial options are set, you will encounter only the text and the helpful links guiding you through the document.

3.1.2.1
Opening the Tutorial Web Page

We presume that Internet Explorer 5.0 or above is already installed on you computer. Do the following steps to start the Web page:

1. Press WINDOWS key to open the Start Menu

2. Press P to open the Programs menu

3. Press I to start the Internet Explorer browser. If there are more applications installed on your computer, which start with the letter I, then you have to press I repeatedly until you select the Internet Explorer. Then press ENTER to start it.

4. In Internet Explorer press CONTROL+O to open the Open dialog

5. Type in the address of the ‘Train the Users’ Manual:
www.aib.uni-linz.ac.at/accelerate/ttu/
and press ENTER.

3.1.2.2
Tutorial Options

The only link on the title page of the Tutorial leads you to the Options page. This is the only way to access the Tutorial for a newcomer. The tutorial tries to meet exactly the needs of every user taking in account the hardware and software he/she uses.

After all the options are properly chosen, pressing the Send button brings you to the highest Quick Contents level of the Tutorial. We strongly recommend that all newcomers start by reading the Introduction.

3.1.2.3
Saving your personal Tutorial Settings

It is necessary to set the Tutorial options only once – the first time you visit it. To continue working with the Tutorial exactly on the same place where you paused and with the options you have selected, do the following two steps:

1. Before exiting the Internet Explorer or changing to an other Web page, save your current Tutorial position to the Favorites.

a. Press ALT+A to bring up the Favorites menu

b. Press A to open the Add Favorites dialog

c. Memorize the suggested link name for your current position or change it to a name of your choice

d. Press ENTER to save the link.

2. When you want to continue with the Tutorial:

a. Start the Internet Explorer application as explained in the section 3.1.2.1

b. Press ALT+A to bring up the Favorites menu

c. In the List of Favorites select the name of the link to your current position in the Tutorial. You can do it with UP and DOWN ARROW keys or by repeatedly pressing the first letter of the link name.

d. Press ENTER to open the Tutorial at the position where you interrupted.

3.2
Internet Explorer with JAWS

3.2.1
Introduction

Internet Explorer 5.0 is a suite of tightly integrated programs that connect your computer to the information that is available through the Internet and the Intranets. Internet Explorer not only acts as a browser to display the data, but it also helps you find, incorporate, and interact with that data. Internet Explorer also includes all the tools needed for you to communicate your message globally.

3.2.2
Getting Started

It is recommended that you use IE 5.0 with JAWS for Windows 3.5. IE 4.01 and 3.0 are still supported as they have been in earlier versions of JFW, but JFW 3.5 takes advantage of newer technology that is only available in IE 5.0. These applications will run under Microsoft Windows 95, Windows 98, and Microsoft Windows NT. When using Microsoft Windows NT, Service Pack 4 or later is required.

3.2.3
JAWS Specific Internet Explorer Keystrokes

Address Bar: INSERT+A. Reads the Address bar while maintaining the place on the page so you can be in two places at once. Pressing INSERT+A twice quickly will move the JAWS cursor to the address bar. ALT+D an IE 5 keystroke, selects the text on the Address bar. Either type in a new address, copy or cut and paste to the clipboard.

Focus To First Field: CONTROL+INSERT+HOME. Moves to the first input field in the page and speaks it. If no form field is found, JFW reports, “Input Field Not Found.”

IE Find: CONTROL+F. Turns on Internet Explorer Find, unless JAWS is running. If JFW is running it calls up the JAWS Find Dialog, which will search the entire document.

Move To Non-Link Text: INSERT+ENTER. Moves to the next block of non-link text that is larger than 25 characters. 
Note: This value can be adjusted in the default.jcf or browseui.jcf (Internet Explorer 5) JAWS configuration files under Set Options\HTML.

Refresh Screen: INSERT+F5. If the virtual cursor is active, and screen tracking for the virtual cursor is off, this will bring the area of the screen with the virtual cursor in it into view. Using just F5 is an Internet Explorer keystroke, which will refresh the screen.
Note: There are differences between refreshing and updating a screen.

Update Screen: INSERT+ESCAPE. Use this keystroke to update the screen contents when in PC cursor mode.

Read Current Screen: CONTROL+INSERT+DOWN ARROW. Reads the body of the page from the top with the JAWS cursor.
Note: This is only available in non-virtual cursor mode.

Read Next Screen: CONTROL+INSERT+PAGE DOWN. Reads the next screen. Does a PAGE DOWN and begins reading with the JAWS cursor.
Note: This is only available in non-virtual cursor mode.

Read Previous Screen: CONTROL+INSERT+PAGE UP. Reads the prior screen. Does a PAGE UP and begins reading with the JAWS cursor.
Note: This is only available in non-virtual cursor mode.

Reformat Document: INSERT+F5. Reformats multiple column pages to be more readable with speech. Rearranges multiple column pages to read in a linear fashion. IE columns are read one after another.
Note: This is only available in non-virtual cursor mode.

Say Selected Link: INSERT+TAB. Says the focused link or control. If in a dialog, speaks the current control. If in a Web page, announces the link or control with focus.

Select A Frame: INSERT+F9. Brings up a dialog containing a list of the frames present in the page. Select a frame from the list and press ENTER. The focus will move to the frame you selected and speak its content

Select A Link: INSERT+F7. Brings up a dialog containing a list of the links present in the page. You can then select a link by using the ARROW keys or the first letter of the link. Press ENTER to open the selected link. You may also tab between the various controls in the select a link dialog.

Tool Bar: INSERT+F8. Brings up a dialog containing toolbar buttons. You can select one of the buttons on the toolbar. Press ENTER to select.

Virtual PC Cursor Toggle: INSERT+Z. Toggles the virtual cursor on and off. When in a Web document this command toggles between the classic style interface and the Virtual PC cursor interface.

3.2.4
Helpful Hints

When you use Internet Explorer 5.0 with JFW, you work in one of three modes;

Virtual PC cursor mode

Forms mode or

Conventional mode.

3.2.4.1
Virtual PC Cursor Mode

The Virtual PC cursor is activated automatically when you open IE 5, and JFW begins speaking the text on the screen as soon as the page finishes loading. If the newly opened page is loaded, JAWS announces the presence of frames, links, and forms on the page.

Caution: Manually starting to read before the loading has finished often results in less than all of the text being available.

The Virtual PC cursor works in the Internet Explorer 5.0 environment in much the same way that the PC cursor does in other applications. The Virtual PC cursor responds to normal screen reading keys in the same way, but there may be no visual indication on the area of the screen that is being affected. The default action is for the screen to track with the virtual cursor, but you can change this setting in the configuration manager under Set Options\HTML.

Note: If you wish for a sighted user to be able to view the area of the screen you are currently in, and you have disabled screen tracking of the virtual cursor in the browseui (Internet Explorer 5) or default configuration files, you can route JAWS to the Virtual cursor in order to read the actual text on the screen. Also, you can press INSERT+ESCAPE, which will update the screen, and bring the page that the virtual cursor is on into view.

When reading a Web page with the Virtual PC cursor, you can select text using the standard Windows text selection keys, though there is no visual feedback of what is being selected. The Say Selected Text command (SHIFT+INSERT+DOWN ARROW) speaks the text that has been selected.

When a page with frames first comes up, all frames are readable in sequential order. With INSERT+F1 you are told, “The page contains frames.” As you enter a frame, you hear, “Navigation Frame,” As you leave a frame, you hear “Navigation Frame End.” CONTROL+HOME brings the top of the document into view on the visual screen, CONTROL+END brings the bottom of the document into view on the visual screen, PAGE DOWN moves down 24 lines, and PAGE UP moves up 24 lines.

Say All in line mode reads the document from top to bottom, and when pressing CONTROL to stop Say All, you are positioned near the last item read. You can navigate reading by line, sentence, or paragraph, as well as by moving by words and characters.

When reading text on a Web page, each link appears to be on its own line, even though this may not be true on the screen. Visited links are identified as “visited.” They are also properly categorized as visited in the Links List dialog. When JFW encounters a link that does not have any text associated with it, one of two things is announced. If the link is a CGI link, the name of the graphic is spoken. Otherwise, the last directory component and the file name of the URL is spoken instead.

When you are using the Virtual cursor and you encounter a link on the screen that has an ALT tag, JAWS will read that tag since it is more descriptive.

To quickly skip past headers, you can press INSERT+ENTER. This moves you down through the page to the first text of at least 25 characters that is not a link. When the virtual cursor arrives at the text, the current line is read.

When the cursor is on a line with a link, pressing ENTER or NUMPAD SLASH activates that link. Subsequently, pressing BACKSPACE moves you back to your last position on the last page read.

Note: The Context menu accessed by the Applications key does not apply to the Virtual cursor.

The Virtual PC cursor is enabled in DEFAULT.JCF. If you do not want to use the Virtual PC cursor, turn it off by un-checking the “Use the Virtual PC Cursor” checkbox under the Advanced setting of the Configuration Manager in DEFAULT.JCF. If you want to have this cursor disabled every time you are in IE 5, you can uncheck this box in BROWSEUI.JCF. Unchecking this checkbox means that you will be operating in conventional cursor mode.

Note: The INSERT+F5 key command for reformatting a Web page is no longer necessary with virtual cursor mode. You will need to switch to conventional mode if you wish to reformat the page.

3.2.4.2
Forms Mode

With the Virtual PC cursor positioned on a form field, press ENTER or the NUMPAD SLASH key to switch to Forms mode. You will hear "Forms Mode On,” the information and the name of the control you are on. When you press ENTER to go into Forms mode, the PC cursor is activated on the current control. As a result,

if you are on a button, the button is pressed

if you are on a checkbox, the state of the checkbox is toggled

if you are on a radio button that is unchecked, the radio button is checked, however, if it was already checked, it remains unchanged

if you are on an edit box, the PC cursor is placed at the top of the edit field

with Combo boxes, the first item is selected.

TAB and SHIFT+TAB must be used to move between fields in forms mode. When using these keys for navigation, the natural tab order is used, including any links that may appear between fields. As you land on the different controls, JAWS announces the new control, such as a link or a field.

While in forms mode you can navigate edit fields using the PC cursor as you normally do (i.e. tab and SHIFT+TAB).

To exit Forms mode, press NUMPAD PLUS to activate the Virtual PC cursor.

Note: JFW remains in Forms mode until the Virtual PC cursor is activated or a new page is displayed. Pressing INSERT+ESCAPE also returns you to Virtual Cursor mode and moves the position of the Virtual PC cursor to the first control on the current page.

Tip: Return to the Virtual PC cursor using the familiar NUMPAD PLUS. This turns Forms Mode off.

3.2.4.3
Conventional Mode

This mode is also referred to as classic style cursor mode.

By unchecking the checkbox, using the Virtual PC cursor in the Advanced settings dialog of the Configuration Manager, you can navigate IE using the JAWS cursor and reformatting options that were used by JFW in IE 4.01. In this mode, functionality provided by the virtual cursor will be unavailable. To find out more about how the conventional mode works, see “IE 4 Help” in the JAWS Help System.

Note: To temporarily toggle between Virtual PC cursor and Conventional cursor modes, press INSERT+Z.

Note: The following changes are important if you plan to use JFW and IE 5.0 with the virtual cursor turned off. Some of these changes may not be necessary when using the virtual cursor.

There are several advanced options that should be changed for optimal performance of JFW with IE when navigating with the cursor in classic mode. 

Open the Internet Options dialog under the Tools menu and go to the Advanced page.

Under The Accessibility Section, Make Sure The Following Are Checked:

Move system caret with focus/selection changes.

Always expand ALT text for images.

Under The Browsing Section, Make Sure The Following Are Not Checked:

Show friendly URLs.

Use smooth scrolling.

Enable page transitions.

In the accessibility dialog, make sure "ignore colours specified on Web pages" is checked.

This dialog opens when you press the Accessibility button in the General page of the Internet Options dialog.

Note: You may want to turn off some of the multimedia options to increase speed when loading pages.

3.2.5
Links List Dialog

Another tool JFW provides for navigating Web pages on the Internet is the links list dialog. When in Internet Explorer, you can bring up the Links List dialog by pressing INSERT+F7. When you find yourself in this dialog, you are automatically placed in the Links List view. The first time you enter this dialog in a JAWS session, this list will be sorted in tab order and will show all available links. You can use the filter and sort order options in this dialog to change the way the links are displayed in the links list. If the links have the same name but point to different locations, each one is listed in this list view.

If the user filters or organizes their list in the Link List Dialog, this setting will remain until they change it or exit JFW. The default setting that ships with JFW is All Links in Tab Order.

The status line of the Links List dialog contains the selected link in the list view followed by the URL for selected link.

Visited links are determined by what IE indicates as a visited link. Because of this, if a link is visited somewhere on the same page, the link is marked as visited even though you have not activated the link. Also, if you have visited a particular URL and then go to a page that has a link to that URL, the link is then marked as visited. If IE 5 does not show that it is a visited link, JAWS will not either.

3.2.6
HTML Tables

HTML tables now support navigation using the Virtual PC cursor. While in an HTML table, you can hear the contents, row title, and column title of the cell where the Virtual PC cursor is located by using the keystrokes shown in the section 2.5.3.2: Table Reading Functions.

3.3
Internet Explorer with Supernova

Access to the Web can be improved by ensuring your Web Browser is configured for optimal performance, that your Dolphin software is configured for optimal performance and by ensuring you have the latest Dolphin software release.

3.3.1
Internet Explorer Configuration

In brief, removing the status bar and hiding those unwanted toolbars will give users good access to web pages through Internet Explorer.  However, here you find some changes required to optimize Internet Explorer 5.0.

Turning off images and hiding the status bar will optimize Internet Explorer 5.0's performance.  The use of "Ignore colours" will aid navigation by identifying the links visited and those not yet activated when used in conjunction with Hal or Supernova's colour announcement option.

Turning off images will mean Web pages download faster, however, use of the new MSAA support in Hal and Supernova, version 4.04 means this action is not a necessity.

Hiding the status bar in Internet Explorer 5.0 means as Web pages load they will retain the focus and hence are automatically spoken.

To hide images:

1. Press ALT+T to go to the Tools menu. Then LETTER O  for  Internet Options.

2. When the box appears, press SHIFT+CONTROL+TAB to switch to the "Advanced" property sheet.

3. The cursor will be on "Accessibility".  Cursor down once and you will find "Always expand ALT text for images".

4. Select this option by pressing SPACE.
Selecting "Always expand ALT text for images" ensures the alternate text presented for the image will be displayed in full and not restricted by the initial size of the image.

5. Now, Press the letter M twice to reach the "Multimedia".

6. Use DOWN ARROW to find "Play Animations" and turn this off by pressing SPACE.

7. Use DOWN ARROW again until you hear "Show Pictures" and turn this off too.

8. TAB to the OK button and press ENTER.

To hide the status bar:

1. Go to the View menu by pressing ALT+V.

2. Use DOWN ARROW until "Status bar" is selected.

3. Press ENTER to de-select (i.e. hide) the status bar.

A further option worth consideration is the hiding of those additional Toolbars and Explorer Bars that simply clutter the screen and reduce the amount of information shown at any time.  We would recommend options such as the "Standard Buttons", "Links" and all Explorer Bars be hidden.

To select "Ignore colours" in Internet Explorer's Accessibility options:

1. Run Internet Explorer

2. Go to "Internet Options" by pressing ALT+T then O.

3. From the "General" property sheet press ALT+E to open the "Accessibility" options.

4. Press ALT+C to select "Ignore colours specified on web pages" then TAB on through to the OK button.

5. Press ENTER.

3.3.2
Hal Or Supernova Configuration

The key configuration for Hal or Supernova is to select "Colour Change" announcement in Navigation Modes' and Prompt Areas' settings.  This will enable the identification of links visited and unvisited on a web page.  With this selected and Internet Explorer's Accessibility option "Ignore colours specified on web pages" also selected, a uniform colour will be applied to links previously activated and those unvisited.  This is an easy way to keep track on where you've been and where you might like to go!

To select Navigation Mode's "Colour Change" announcement in Hal or Supernova's Control Panel:

Press LEFT CONTROL+SPACE to open the Control Panel.

Press CONTROL+TAB to open the "Application Settings" property sheet.

Press ALT+G to open the "General Settings" option.

Press ALT+N to open the "Navigation Mode" dialog box.

Press ALT+U to move to the "Announce" group.

TAB to "Colour Change" and press SPACE to select. 

TAB on through to the OK button to confirm the change.

To select Prompt Areas' "Colour Change" in Hal or Supernova's Control Panel.

Press LEFT CONTROL+SPACE to open the Control Panel.

Press CONTROL+TAB to open the "Application Settings" property sheet.

Press ALT+S to open the "Situation Settings" option.

Press ALT+S once again to open the "Speech" dialog box.

Use the ARROW keys to select the radio button "Prompt Areas".

Press ALT+U to move to the "Announce" group.

TAB to "Colour Change" and press SPACE to select. 

TAB on through to the OK button to confirm the change.

Remember, through the use of Settings Files you can ensure any changes you would like Supernova, Hal, LunarPlus or Lunar to adopt when using a given application can be saved away.  This means you only need to adjust the settings once and they will be automatically loaded each time the application (e.g. Internet Explorer) is launched!  

For further information on the creation and management of Settings Files please review the product's Online Help.

3.3.3
Tips On Navigating Web Pages

Web pages can be navigated in two ways either directly or through Hal or Supernova's Navigation Mode.  In reality it is a combination of both these styles that will offer users the best access!

Here are some useful Hal/Supernova speech keystrokes to aid navigating.

Read the Window
Number Pad Delete

Read a Link
Number Pad Zero

Spell a Link
Shift+Number Pad Zero

Read Link Phonetically
Shift+Control+Number Pad Zero

Read a Line
Number Pad Six 

Where am I Key
Number Pad Minus

See the section 2.6.1.4 for Hal/Supernova's Navigation Mode Keys.

We would also strongly recommend a review of the "Navigation Mode" section in Hal/Supernova's Online Help as this feature can prove a powerful tool in web page navigating.

Finally, users may find access to the Internet further enhanced through use of the Web Accessories that accompany Internet Explorer 5.0 or the PowerToys for Internet Explorer 4.01.

These add-ons can be downloaded from the Microsoft web site and offer, amongst other features, the ability to view a "Links list".  The "Links list" when called will bring up a list of all the links present on the open web page in a separate window.  This is a good tool to have as it offers potentially needed information on web pages that offer little or no text support (e.g. a web page filled with graphical links that doesn't contain alternate text).

3.3.4
Hal/Supernova Find Feature

The Find feature means users can quickly navigate to text (even ALT text behind images) quickly and easily.  This is helpful on web pages but also is a great tool for those applications that are lacking a good keyboard interface!

The Find feature is held within Navigation Mode and is activated by pressing F3.  After entering your search criteria you begin by pressing ENTER.  F2 and F4 will continue the search moving back and forward respectively through the navigation area.  During this search process you remain in Navigation Mode and, therefore, can continue navigating at any point.

3.3.5
Dolphin Link Navigator

This is an accessory/plug in from Dolphin for Microsoft Internet Explorer versions 5.0 and 5.5 that provides a user friendly alternative to the Microsoft web accessory for links display, this plugs into Internet Explorer and provides a much more accessible 'Links List' utility.  There is the option to install it when you install version 4.50 of Hal, Supernova, LunarPlus and Lunar. Once installed, you can find the "Dolphin Link Navigator" in the Tools menu in Microsoft Internet Explorer, from the keyboard press Alt-T and then T to activate it.

The Dolphin Link Navigator should be easy to use, there are radio buttons to select the sort order of the web page links in either 

1. tab order i.e. in the order you would tab around the links on the web page

2. listed in an a to z order or 

3. listed in an z to a order or 

4. recently visited order.

To select a link just tab to the links list then use the ARROW keys (or press a letter key to jump to the first link starting with that letter) to move to a link, then press ENTER to select the link. 

Note: You may need to use ALT+TAB to move back to Internet Explorer.

Please note that the text of the link is displayed along with the URL that is associated with the link, the purpose of this being to deal with links that just say "click here" or something like that.  

If you want the link navigator to remember your sort order settings, you must have cookies enabled in Internet Explorer.
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